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1. Introduction 

 

This short guide explains how to apply weights to the data from the Wales Outdoor Recreation Survey 

(WORS). It is aimed at those who have downloaded the data from the Natural Resources Wales website 

and intend to run their own analysis.   

 

The WORS weighting system corrects for both proportion and scale – i.e. it adjusts the results to reflect 

both the underlying characteristics and the size of the adult population living in Wales. For further 

information about the weighting system please see the WORS Technical Report available from the 

Natural Resources Wales website1. 

 

WORS collects a range of information about people’s visits to the natural environment. This includes the 

type of destination, the duration of the visit, mode of transport, distance travelled, spend, main 

activities and motivations for the visit. It collects data on people that do not visit the natural 

environment and the reasons for this. 

2. File types  

 

Raw data is available in SPSS and Excel formats with the weights presented as a series of variables 

within each dataset.  

 

There are two separate weights that can be applied to the WORS dataset – one that relates to visits 

taken to the natural environment by respondents in the four weeks prior to interview (the visit based 

data); the other is for findings from other questions that are not dependant on whether a respondent 

has taken such a visit (the respondent based data). The weights are presented as a series of variables 

within each dataset. 

3. Choosing the correct weights  

 

The weights gross the sample result up to the adult population of Wales (for the respondent based data) 

or the estimated visits taken (visit based data). After the weights are applied, read all figures as 

thousands i.e. a figure of 1,000 should be read as 1,000,000.  

 

For a full list of WORS questions and weights please see sections 6 and 7.  

                                                           
1 www.cyfoethnaturiolcymru.gov.uk /www.naturalresourceswales.gov.uk 

 

http://www.cyfoethnaturiolcymru.gov.uk/
http://www.naturalresourceswales.gov.uk/
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4. Applying weights in SPSS  

 

1. Start SPSS and load the data using the File> Open> Data command.  

 

2. To weight the data select Data> Weight Cases. This will open the Weight Cases dialog box. 

 

3. Select Weight Cases By, and then in the left hand column select the weight variable to use for 

the analysis (RespondentWeight for Respondent based results, VisitWeight for Visit based results - 

see section 6 for details of which weight to apply). 

 

4. Once the weight is applied, SPSS confirms the status of the data in the data view window. 

 

5. If a file is weighted by some variable it remains so until the order is cancelled by returning to the 

Data> Weight Cases menu and either turning the weights off, or establishing another weight 

variable. If a weighted file is saved, it will still be weighted when re-opened. 

5. Applying weights in Excel 

 

The procedure for weighting data in Excel uses pivot table reports already included in the spreadsheet.  

 

1. Open the relevant data file and choose ‘Tab 1 – WORS2014’  

 

2. Select side break by dragging variable to Row Labels.  

 

3. If required select a cross break (e.g. Age) by dragging variable to Column Labels 

 

4. If required, add filter to apply (e.g. so results are only shown for a certain are or sub-group) by 

dragging variable to Report Filter. 

 

5. Select the appropriate weighting variable and drag it into Values. Please see section 6 for a 

guide to the correct to apply for each question.  

 

6. The pivot table report will produce figures with the correct weights added. To see the raw data 

click on sheet 2. 

 



260119555 WORS Excel & SPSS weighting guide FV 

3 
July 2015 

6. Weighting list and application guide 

 

The table below specifies the datasets and weights that should be used when undertaking analysis of the MENE raw data – either in SPSS, CSV or 

Excel format. Please see the WORS Technical Report for the full questionnaire. 

 

 

Question Weighting to apply 

Q1a – Activities done during visits to the outdoors in the last 12 months Respondent  

Q2 – Activities done during visits to the outdoors in the last 4 weeks Respondent 

Q3a – Number of visits to the outdoors in the last 4 weeks Respondent 

Q4 – Activities done on most recent visit to the outdoors Visit  

Q4c – Main activity done on most recent visit to the outdoors Visit 

Q5 – Time spent doing main activity most recent visit Visit 

Q6a – Whether effort enough to raise breathing rate Visit 

Q6b – Whether effort enough to make them out of breath/ sweat Visit 

Q7a – Places visited on most recent visit to the outdoors Visit 

Q7b – Main place visited on most recent visit to the outdoors Visit 

Q8 – Distance travelled to reach destination of most recent visit Visit 
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Q9 – Main mode of transport used on most recent visit Visit 

Q10 – Visit duration (most recent visit) Visit 

Q11 – Who with on most recent visit Visit 

Q12 – Number of people in party (most recent visit) Visit 

Q13 – Number of children in party (most recent visit) Visit 

Q14 – Whether with a dog (most recent visit) Visit 

Q15 – Reasons for visiting (most recent visit) Visit 

Q15a – Whether spent any money on most recent visit – by category Visit 

Q15b – Amount spent on most recent visit – by category Visit 

Q16 – Reasons not made any visits to the outdoors in the last 4 weeks Respondent 

Q16a – Reasons not made any visits to the outdoors in the last 12 months Respondent 

Q17 – Whether would like to visit outdoors more often Respondent 

Q18 – Activities would like to do/ do more often Respondent 

Q19 – Barriers to taking part in activities at all/ more often in last 12 months Respondent 

Q20 – Places visited (last 12 months) Respondent 

Q21 – Places would like to visit/ visit more often Respondent 



260119555 WORS Excel & SPSS weighting guide FV 

5 
July 2015 

Q22a – Whether there has been a change in biodiversity in Wales Respondent 

Q22b – Whether there will be a change in biodiversity in Wales in the future Respondent 

Q23 – Concern about changes to variety of species in Wales Respondent 

Q24 – Pro-environmental activities undertaken in last 12 months Respondent 

D1 – Gender Respondent 

D2/3 – Age Respondent 

D4 – Ethnicity Respondent 

D5 – Highest educational qualification Respondent 

D6 – Car access Respondent  

D7 – Bicycle access Respondent 

D8 – Whether own/ care for a dog Respondent 

D9 – Long-term illness/disability Respondent 

D10 – Whether long-term illness/disability limits activities Respondent 

D11 – Whether carer Respondent 

D12 – Children under 16 (care for/ support) Respondent 

D13 – Working status Respondent 
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D17 – Household income Respondent 

 

7. Variable guide 

 

The table below specifies variable names and labels in the WORS raw data files (SPSS and MS Excel format) available to download from the Natural 

Resources Wales website2.    

 

Variable Variable label 

q1a_01 Activities undertaken on outdoor visits (last 12 months): Walking 

q1a_02 Activities undertaken on outdoor visits (last 12 months): Road cycling 

q1a_03 Activities undertaken on outdoor visits (last 12 months: Off-road cycling or mountain biking 

q1a_04 Activities undertaken on outdoor visits (last 12 months): Horse riding 

q1a_05 Activities undertaken on outdoor visits (last 12 months): Fishing 

q1a_06 Activities undertaken on outdoor visits (last 12 months): Rock climbing or caving 

q1a_07 Activities undertaken on outdoor visits (last 12 months): Motorised watersports 

q1a_08 Activities undertaken on outdoor visits (last 12 months): Other watersports 

q1a_09 Activities undertaken on outdoor visits (last 12 months): Swimming outdoors 

q1a_10 Activities undertaken on outdoor visits (last 12 months): Snowsports 

q1a_11 Activities undertaken on outdoor visits (last 12 months): Field sports (shooting / hunting) 

q1a_12 Activities undertaken on outdoor visits (last 12 months): Air sports (hang gliding / ballooning) 

q1a_13 Activities undertaken on outdoor visits (last 12 months): Wildlife watching 

                                                           
2 www.cyfoethnaturiolcymru.gov.uk /www.naturalresourceswales.gov.uk 

http://www.cyfoethnaturiolcymru.gov.uk/
http://www.naturalresourceswales.gov.uk/
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q1a_14 Activities undertaken on outdoor visits (last 12 months): Running 

q1a_15 Activities undertaken on outdoor visits (last 12 months): Sightseeing or visiting an attraction 

q1a_16 Activities undertaken on outdoor visits (last 12 months): Off-road driving or motorcycling 

q1a_17 Activities undertaken on outdoor visits (last 12 months): Picnicking (as a significant part of the activity) 

q1a_18 Activities undertaken on outdoor visits (last 12 months): Visiting children's playgrounds/taking children to 

play areas outdoors 

q1a_19 Activities undertaken on outdoor visits (last 12 months): Informal games 

q1a_20 Activities undertaken on outdoor visits (last 12 months): Others 

q1a_21 Activities undertaken on outdoor visits (last 12 months): No answer 

q2_01 Activities undertaken on outdoor visits (last 4 weeks): Walking 

q2_02 Activities undertaken on outdoor visits (last 4 weeks): Road cycling 

q2_03 Activities undertaken on outdoor visits (last 4 weeks): Off-road cycling or mountain biking 

q2_04 Activities undertaken on outdoor visits (last 4 weeks): Horse riding 

q2_05 Activities undertaken on outdoor visits (last 4 weeks): Fishing 

q2_06 Activities undertaken on outdoor visits (last 4 weeks): Rock climbing or caving 

q2_07 Activities undertaken on outdoor visits (last 4 weeks): Motorised watersports 

q2_08 Activities undertaken on outdoor visits (last 4 weeks): Other watersports 

q2_09 Activities undertaken on outdoor visits (last 4 weeks): Swimming outdoors   

q2_10 Activities undertaken on outdoor visits (last 4 weeks): Snowsports 

q2_11 Activities undertaken on outdoor visits (last 4 weeks): Field sports (shooting / hunting) 

q2_12 Activities undertaken on outdoor visits (last 4 weeks): Air sports (hang gliding / ballooning) 

q2_13 Activities undertaken on outdoor visits (last 4 weeks): Wildlife watching 

q2_14 Activities undertaken on outdoor visits (last 4 weeks): Running  
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q2_15 Activities undertaken on outdoor visits (last 4 weeks): Sightseeing or visiting an attraction 

q2_16 Activities undertaken on outdoor visits (last 4 weeks): Off-road driving or motorcycling 

q2_17 Activities undertaken on outdoor visits (last 4 weeks): Picnicking (as a significant part of the activity) 

q2_18 Activities undertaken on outdoor visits (last 4 weeks): Visiting children's playgrounds/taking children to 
play areas outdoors  

q2_19 Activities undertaken on outdoor visits (last 4 weeks): Informal games 

q2_20 Activities undertaken on outdoor visits (last 4 weeks): Other  

q2_21 Activities undertaken on outdoor visits (last 4 weeks): No answer 

q3a Number of visits to outdoors in last 4 weeks 

q4a_01 Activities undertaken (most recent outdoor visit): Walking 

q4a_02 Activities undertaken (most recent outdoor visit): Road cycling 

q4a_03 Activities undertaken (most recent outdoor visit): Off-road cycling or mountain biking 

q4a_04 Activities undertaken (most recent outdoor visit): Horse riding 

q4a_05 Activities undertaken (most recent outdoor visit): Fishing 

q4a_06 Activities undertaken (most recent outdoor visit): Rock climbing or caving  

q4a_07 Activities undertaken (most recent outdoor visit): Motorised watersports 

q4a_08 Activities undertaken (most recent outdoor visit): Other watersports 

q4a_09 Activities undertaken (most recent outdoor visit): Swimming outdoors 

q4a_10 Activities undertaken (most recent outdoor visit): Snowsports 

q4a_11 Activities undertaken (most recent outdoor visit): Field sports (shooting / hunting) 

q4a_12 Activities undertaken (most recent outdoor visit): Air sports (hang gliding / ballooning) 

q4a_13 Activities undertaken (most recent outdoor visit): Wildlife watching 

q4a_14 Activities undertaken (most recent outdoor visit): Running 
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q4a_15 Activities undertaken (most recent outdoor visit): Sightseeing or visiting an attraction 

q4a_16 Activities undertaken (most recent outdoor visit): Off-road driving or motorcycling 

q4a_17 Activities undertaken (most recent outdoor visit): Picnicking (as a significant part of the activity) 

q4a_18 Activities undertaken (most recent outdoor visit): Visiting children's playgrounds/taking children to play 
areas outdoors 

q4a_19 Activities undertaken (most recent outdoor visit): Informal games 

q4a_20 Activities undertaken (most recent outdoor visit): Other 

q4c Main activity undertaken (most recent visit) 

q5_01 Time spent in outdoors (most recent visit): 0 - 29 minutes 

q5_02 Time spent in outdoors (most recent visit): 30 - 59 minutes 

q5_03 Time spent in outdoors (most recent visit): 1 hr - 1 hr 59 

q5_04 Time spent in outdoors (most recent visit): 2 hr - 2 hr 59 

q5_05 Time spent in outdoors (most recent visit): 3 hr - 4 hr 59 

q5_06 Time spent in outdoors (most recent visit): 5 hours or more 

q5_07 Time spent in outdoors (most recent visit): Don't know 

q6a Whether activity enough to raise breathing rate 

q6b Whether activity enough to make out of breath/sweat 

q6a_b Whether done activity that raised breathing rate/caused to sweat 

q7a_01 Places visited (most recent visit): Woodland or forest 

q7a_02 Places visited (most recent visit): Farmland 

q7a_03 Places visited (most recent visit): Local park 

q7a_04 Places visited (most recent visit): Other local open space 

q7a_05 Places visited (most recent visit): Roadside pavement/track 
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q7a_06 Places visited (most recent visit): Hills, mountains or moorland 

q7a_07 Places visited (most recent visit): River, lake or canal 

q7a_08 Places visited (most recent visit): Beach 

q7a_09 Places visited (most recent visit): Sea 

q7a_10 Places visited (most recent visit): Other coastline 

q7a_11 Places visited (most recent visit): Village 

q7a_12 Places visited (most recent visit): Other 

q7b Main place visited (most recent visit) 

q8 Distance travelled (most recent visit) 

q9 Main mode of transport (most recent visit) 

q10 Total visit duration (most recent visit) 

q11_01 Who with (most recent visit): No-one, I went on my own  

q11_02 Who with (most recent visit): I went with my family 

q11_03 Who with (most recent visit): I went with my friends 

q11_04 Who with (most recent visit): I went as part of an organised group 

q11_05 Who with (most recent visit): Other 

q12 Number of people in party (most recent visit) 

q13 Number of children in party (most recent visit) 

q14 Whether accompanied by dog (most recent visit) 

q15_01 Reasons for visiting outdoors (most recent visit): To spend time with family  

q15_02 Reasons for visiting outdoors (most recent visit): To spend time with friends 

q15_03 Reasons for visiting outdoors (most recent visit): To learn something about the outdoors  

q15_04 Reasons for visiting outdoors (most recent visit): For fresh air or to enjoy pleasant weather 
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q15_05 Reasons for visiting outdoors (most recent visit): For health or exercise 

q15_06 Reasons for visiting outdoors (most recent visit): For peace and quiet 

q15_07 Reasons for visiting outdoors (most recent visit): To relax and unwind 

q15_08 Reasons for visiting outdoors (most recent visit): To exercise your dog 

q15_09 Reasons for visiting outdoors (most recent visit): To enjoy scenery and wildlife 

q15_10 Reasons for visiting outdoors (most recent visit): To entertain children 

q15_11 Reasons for visiting outdoors (most recent visit): To challenge myself 

q15_12 Reasons for visiting outdoors (most recent visit): To achieve something 

q15_13 Reasons for visiting outdoors (most recent visit): To enjoy/participate in my hobby 

q15_14 Reasons for visiting outdoors (most recent visit): Don't know 

q15_15 Reasons for visiting outdoors (most recent visit): For pleasure/enjoyment 

q15_16 Reasons for visiting outdoors (most recent visit): To get somewhere (e.g. walking to work/shops) 

q15_17 Reasons for visiting outdoors (most recent visit): Other 

q15a_01 Any expenditure on items during visit: Food and drink 

q15a_02 Any expenditure on items during visit: Petrol/diesel/LPG 

q15a_03 Any expenditure on items during visit: Car parking 

q15a_04 Any expenditure on items during visit: Bus/Train/ferry fares 

q15a_05 Any expenditure on items during visit: Hire of equipment 

q15a_06 Any expenditure on items during visit: Purchase of equipment 

q15a_07 Any expenditure on items during visit: Maps/guidebooks/leaflets 

q15a_08 Any expenditure on items during visit: Gifts/souvenirs 

q15a_09 Any expenditure on items during visit: Admission fees 

q15a_10 Any expenditure on items during visit: Other items 
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q15a_11 Any expenditure on items during visit: Didn't spend any money 

q15b_01 Expenditure on Food and drink: Total (all who spent anything on category on visit) 

q15b_02 Expenditure on Food and drink: Less than £1: (all who spent anything on category on visit) 

q15b_03 Expenditure on Food and drink: £1 to £4.99: (all who spent anything on category on visit 

q15b_04 Expenditure on Food and drink: £5 to £9.99 : (all who spent anything on category on visit 

q15b_05 Expenditure on Food and drink: £10 to £14.99: (all who spent anything on category on visit 

q15b_06 Expenditure on Food and drink: £15 to £19.99: (all who spent anything on category on visit 

q15b_07 Expenditure on Food and drink: £20 to £29.99: (all who spent anything on category on visit 

q15b_08 Expenditure on Food and drink: £30 plus: (all who spent anything on category on visit 

q15b_09 Expenditure on Petrol/diesel/LPG: Total: (all who spent anything on category on visit 

q15b_10 Expenditure on Petrol/diesel/LPG: Less than £1: (all who spent anything on category on visit 

q15b_11 Expenditure on Petrol/diesel/LPG: £1 to £4.99: (all who spent anything on category on visit 

q15b_012 Expenditure on Petrol/diesel/LPG: £5 to £9.99: (all who spent anything on category on visit 

q15b_13 Expenditure on Petrol/diesel/LPG: £10 to £14.99: (all who spent anything on category on visit 

q15b_14 Expenditure on Petrol/diesel/LPG: £15 to £19.99: (all who spent anything on category on visit 

q15b_15 Expenditure on Petrol/diesel/LPG: £20 to £29.99: (all who spent anything on category on visit 

q15b_16 Expenditure on Petrol/diesel/LPG: £30 plus: (all who spent anything on category on visit 

q15b_17 Expenditure on Car parking: Total: (all who spent anything on category on visit 

q15b_18 Expenditure on Car parking: Less than £1:: (all who spent anything on category on visit 

q15b_19 Expenditure on Car parking: £1 to £4.99: (all who spent anything on category on visit 

q15b_20 Expenditure on Car parking: £5 to £9.99: (all who spent anything on category on visit 

q15b_21 Expenditure on Car parking: £10 to £14.99: (all who spent anything on category on visit 

q15b_22 Expenditure on Car parking: £15 to £19.99: (all who spent anything on category on visit 
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q15b_23 Expenditure on Car parking: £20 to £29.99: (all who spent anything on category on visit 

q15b_24 Expenditure on Car parking: £30 plus: (all who spent anything on category on visit 

q15b_25 Expenditure on Bus/Train/ferry fares: Total: (all who spent anything on category on visit 

q15b_26 Expenditure on Bus/Train/ferry fares: Less than £1: (all who spent anything on category on visit 

q15b_27 Expenditure on Bus/Train/ferry fares: £1 to £4.99: (all who spent anything on category on visit 

q15b_28 Expenditure on Bus/Train/ferry fares: £5 to £9.99: (all who spent anything on category on visit 

q15b_29 Expenditure on Bus/Train/ferry fares: £10 to £14.99: (all who spent anything on category on visit 

q15b_30 Expenditure on Bus/Train/ferry fares: £15 to £19.99: (all who spent anything on category on visit 

q15b_31 Expenditure on Bus/Train/ferry fares: £20 to £29.99: (all who spent anything on category on visit 

q15b_32 Expenditure on Bus/Train/ferry fares: £30 plus: (all who spent anything on category on visit 

q15b_33 Expenditure on Hire of equipment: Total: (all who spent anything on category on visit 

q15b_34 Expenditure on Hire of equipment: Less than £1: (all who spent anything on category on visit 

q15b_35 Expenditure on Hire of equipment: £1 to £4.99: (all who spent anything on category on visit 

q15b_36 Expenditure on Hire of equipment: £5 to £9.99: (all who spent anything on category on visit 

q15b_37 Expenditure on Hire of equipment: £10 to £14.99: (all who spent anything on category on visit 

q15b_38 Expenditure on Hire of equipment: £15 to £19.99: (all who spent anything on category on visit 

q15b_39 Expenditure on Hire of equipment: £20 to £29.99: (all who spent anything on category on visit 

q15b_40 Expenditure on Hire of equipment: £30 plus: (all who spent anything on category on visit 

q15b_41 Expenditure on Purchase of equipment: Total: (all who spent anything on category on visit 

q15b_42 Expenditure on Purchase of equipment: Less than £1: (all who spent anything on category on visit 

q15b_43 Expenditure on Purchase of equipment: £1 to £4.99: (all who spent anything on category on visit 

q15b_44 Expenditure on Purchase of equipment: £5 to £9.99: (all who spent anything on category on visit 

q15b_45 Expenditure on Purchase of equipment: £10 to £14.99: (all who spent anything on category on visit 
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q15b_46 Expenditure on Purchase of equipment: £15 to £19.99: (all who spent anything on category on visit 

q15b_47 Expenditure on Purchase of equipment: £20 to £29.99: (all who spent anything on category on visit 

q15b_48 Expenditure on Purchase of equipment: £30 plus: (all who spent anything on category on visit 

q15b_49 Expenditure on Maps/guidebooks/leaflets: Total: (all who spent anything on category on visit 

q15b_50 Expenditure on Maps/guidebooks/leaflets: Less than £1: (all who spent anything on category on visit 

q15b_51 Expenditure on Maps/guidebooks/leaflets: £1 to £4.99: (all who spent anything on category on visit 

q15b_52 Expenditure on Maps/guidebooks/leaflets: £5 to £9.99: (all who spent anything on category on visit 

q15b_53 Expenditure on Maps/guidebooks/leaflets: £10 to £14.99: (all who spent anything on category on visit 

q15b_54 Expenditure on Maps/guidebooks/leaflets: £15 to £19.99: (all who spent anything on category on visit 

q15b_55 Expenditure on Maps/guidebooks/leaflets: £20 to £29.99: (all who spent anything on category on visit 

q15b_56 Expenditure on Maps/guidebooks/leaflets: £30 plus: (all who spent anything on category on visit 

q15b_57 Expenditure on Gifts/souvenirs: Total: (all who spent anything on category on visit 

q15b_58 Expenditure on Gifts/souvenirs: Less than £1: (all who spent anything on category on visit 

q15b_59 Expenditure on Gifts/souvenirs: £1 to £4.99: (all who spent anything on category on visit 

q15b_60 Expenditure on Gifts/souvenirs: £5 to £9.99: (all who spent anything on category on visit 

q15b_61 Expenditure on Gifts/souvenirs: £10 to £14.99: (all who spent anything on category on visit 

q15b_62 Expenditure on Gifts/souvenirs: £15 to £19.99: (all who spent anything on category on visit 

q15b_63 Expenditure on Gifts/souvenirs: £20 to £29.99: (all who spent anything on category on visit 

q15b_64 Expenditure on Gifts/souvenirs: £30 plus: (all who spent anything on category on visit 

q15b_65 Expenditure on Admission fees: Total: (all who spent anything on category on visit 

q15b_66 Expenditure on Admission fees: Less than £1: (all who spent anything on category on visit 

q15b_67 Expenditure on Admission fees: £1 to £4.99: (all who spent anything on category on visit 

q15b_68 Expenditure on Admission fees: £5 to £9.99: (all who spent anything on category on visit 
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q15b_69 Expenditure on Admission fees: £10 to £14.99: (all who spent anything on category on visit 

q15b_70 Expenditure on Admission fees: £15 to £19.99: (all who spent anything on category on visit 

q15b_71 Expenditure on Admission fees: £20 to £29.99: (all who spent anything on category on visit 

q15b_72 Expenditure on Admission fees: £30 plus: (all who spent anything on category on visit 

q15b_73 Expenditure on Other items: Total: (all who spent anything on category on visit 

q15b_74 Expenditure on Other items: Less than £1: (all who spent anything on category on visit 

q15b_75 Expenditure on Other items: £1 to £4.99: (all who spent anything on category on visit 

q15b_76 Expenditure on Other items: £5 to £9.99: (all who spent anything on category on visit 

q15b_77 Expenditure on Other items: £10 to £14.99: (all who spent anything on category on visit 

q15b_78 Expenditure on Other items: £15 to £19.99: (all who spent anything on category on visit 

q15b_79 Expenditure on Other items: £20 to £29.99: (all who spent anything on category on visit 

q15b_80 Expenditure on Other items: £30 plus: (all who spent anything on category on visit 

q15b_81 Total Expenditure on items: Total : (all who spent anything on visit) 

q15b_82 Total Expenditure on items: Less than £1:(all who spent anything on visit) 

q15b_83 Total Expenditure on items: £1 to £4.99:(all who spent anything on visit) 

q15b_84 Total Expenditure on items: £5 to £9.99:(all who spent anything on visit) 

q15b_85 Total Expenditure on items: £10 to £14.99:(all who spent anything on visit) 

q15b_86 Total Expenditure on items: £15 to £19.99:(all who spent anything on visit) 

q15b_87 Total Expenditure on items: £20 to £29.99:(all who spent anything on visit) 

q15b_88 Total Expenditure on items: £30 plus:(all who spent anything on visit) 

q15bx_01 Expenditure on Food and drink: (all respondents) 

q15bx_02 Expenditure on Petrol/diesel/LPG: (all respondents) 

q15bx_03 Expenditure on Car parking: (all respondents) 
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q15bx_04 Expenditure on Bus/Train/ferry fares: (all respondents) 

q15bx_05 Expenditure on Hire of equipment: (all respondents) 

q15bx_06 Expenditure on Purchase of equipment: (all respondents) 

q15bx_07 Expenditure on Maps/guidebooks/leaflets: (all respondents) 

q15bx_08 Expenditure on Gifts/souvenirs: (all respondents) 

q15bx_09 Expenditure on Admission fees: (all respondents) 

q15bx_10 Expenditure on Other items: (all respondents) 

q15bx_11 Total Expenditure on items: (all respondents) 

q16a_01 Reasons not visited (last 4 weeks): Always too busy / lack of time 

q16a_02 Reasons not visited (last 4 weeks): No-one to look after matters at home while I am away 

q16a_03 Reasons not visited (last 4 weeks): Too difficult with children 

q16a_04 Reasons not visited (last 4 weeks): Too difficult with elderly 

q16a_05 Reasons not visited (last 4 weeks): Too difficult with disabled 

q16a_06 Reasons not visited (last 4 weeks): Bad / poor weather 

q16a_07 Reasons not visited (last 4 weeks): Physical disability 

q16a_08 Reasons not visited (last 4 weeks): Pregnant 

q16a_09 Reasons not visited (last 4 weeks): Old age 

q16a_10 Reasons not visited (last 4 weeks): Other health reason 

q16a_11 Reasons not visited (last 4 weeks): Lack of information on where to go / Don't know where to go 

q16a_12 Reasons not visited (last 4 weeks): Lack of suitable places to go 

q16a_13 Reasons not visited (last 4 weeks): Prefer to go to other places 

q16a_14 Reasons not visited (last 4 weeks): Prefer to do other leisure activities 

q16a_15 Reasons not visited (last 4 weeks): Wouldn't enjoy it 
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q16a_16 Reasons not visited (last 4 weeks): Prevented or discouraged by land owners / managers 

q16a_17 Reasons not visited (last 4 weeks): Nervous or uneasy about what might happen (eg Personal safety, 
getting lost) 

q16a_18 Reasons not visited (last 4 weeks): Not enough money / can't afford it 

q16a_19 Reasons not visited (last 4 weeks): No-one to go with 

q16a_20 Reasons not visited (last 4 weeks): Don't feel like I fit in / belong / am welcome 

q16a_21 Reasons not visited (last 4 weeks): Lack of suitable means of transport / getting there 

q16a_22 Reasons not visited (last 4 weeks): Dislike travelling 

q16a_23 Reasons not visited (last 4 weeks): Not convenient 

q16a_24 Reasons not visited (last 4 weeks): Not interested 

q16a_25 Reasons not visited (last 4 weeks): No particular reason 

q16a_26 Reasons not visited (last 4 weeks): Other 

q16a_27 Reasons not visited (last 4 weeks): Don't know 

q16b_01 Reasons not visited (last 12 months): Always too busy / lack of time 

q16b_02 Reasons not visited (last 12 months): No-one to look after matters at home while I am away 

q16b_03 Reasons not visited (last 12 months): Too difficult with children 

q16b_04 Reasons not visited (last 12 months): Too difficult with elderly 

q16b_05 Reasons not visited (last 12 months): Too difficult with disabled 

q16b_06 Reasons not visited (last 12 months): Bad / poor weather 

q16b_07 Reasons not visited (last 12 months): Physical disability 

q16b_08 Reasons not visited (last 12 months): Pregnant 

q16b_09 Reasons not visited (last 12 months): Old age 

q16b_10 Reasons not visited (last 12 months): Other health reason 
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q16b_11 Reasons not visited (last 12 months): Lack of information on where to go / Don't know where to go 

q16b_12 Reasons not visited (last 12 months): Lack of suitable places to go 

q16b_13 Reasons not visited (last 12 months): Prefer to go to other places 

q16b_14 Reasons not visited (last 12 months): Prefer to do other leisure activities 

q16b_15 Reasons not visited (last 12 months): Wouldn't enjoy it 

q16b_16 Reasons not visited (last 12 months): Prevented or discouraged by land owners / managers 

q16b_17 Reasons not visited (last 12 months): Nervous or uneasy about what might happen (eg Personal safety, 
getting lost) 

q16b_18 Reasons not visited (last 12 months): Not enough money / can't afford it 

q16b_19 Reasons not visited (last 12 months): No-one to go with 

q16b_20 Reasons not visited (last 12 months): Don't feel like I fit in / belong / am welcome 

q16b_21 Reasons not visited (last 12 months): Lack of suitable means of transport / getting there 

q16b_22 Reasons not visited (last 12 months): Dislike travelling 

q16b_23 Reasons not visited (last 12 months): Not convenient 

q16b_24 Reasons not visited (last 12 months): Not interested 

q16b_25 Reasons not visited (last 12 months): No particular reason 

q16b_26 Reasons not visited (last 12 months): Other 

q16b_27 Reasons not visited (last 12 months): Don't know 

q17 Whether would like to visit outdoors more often 

q18_01 Outdoor activities would like to do more often: Walking 

q18_02 Outdoor activities would like to do more often: Road cycling 

q18_03 Outdoor activities would like to do more often: Off-road cycling or mountain biking 

q18_04 Outdoor activities would like to do more often: Horse riding 
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q18_05 Outdoor activities would like to do more often: Fishing 

q18_06 Outdoor activities would like to do more often: Rock climbing or caving 

q18_07 Outdoor activities would like to do more often: Motorised watersports 

q18_08 Outdoor activities would like to do more often: Other watersports 

q18_09 Outdoor activities would like to do more often: Swimming outdoors 

q18_10 Outdoor activities would like to do more often: Snowsports 

q18_11 Outdoor activities would like to do more often: Field sports (shooting / hunting)  

q18_12 Outdoor activities would like to do more often: Air sports (hang gliding / ballooning) 

q18_13 Outdoor activities would like to do more often: Wildlife watching 

q18_14 Outdoor activities would like to do more often: Running 

q18_15 Outdoor activities would like to do more often: Sightseeing or visiting an attraction  

q18_16 Outdoor activities would like to do more often: Off-road driving or motorcycling 

q18_17 Outdoor activities would like to do more often: Picnicking (as a significant part of the activity) 

q18_18 Outdoor activities would like to do more often: Visiting children's playgrounds / taking children to play 
areas outdoors 

q18_19 Outdoor activities would like to do more often: Informal games (eg Frisbee or golf) 

q18_20 Outdoor activities would like to do more often: Other outdoor activities  

q18_21 Outdoor activities would like to do more often: Other 

q18_22 Outdoor activities would like to do more often: No answer 

q18_23 Outdoor activities would like to do more often: Don't know 

q19_01 Reasons for not doing activities at all/more often (last 12 months): Always too busy / lack of time 

q19_02 Reasons for not doing activities at all/more often (last 12 months): No-one to look after matters at home 
while I am away 

q19_03 Reasons for not doing activities at all/more often (last 12 months): Too difficult with children 
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q19_04 Reasons for not doing activities at all/more often (last 12 months): Too difficult with elderly 

q19_05 Reasons for not doing activities at all/more often (last 12 months): Too difficult with disabled 

q19_06 Reasons for not doing activities at all/more often (last 12 months): Bad / poor weather 

q19_07 Reasons for not doing activities at all/more often (last 12 months): Physical disability 

q19_08 Reasons for not doing activities at all/more often (last 12 months): Pregnant 

q19_09 Reasons for not doing activities at all/more often (last 12 months): Old age 

q19_10 Reasons for not doing activities at all/more often (last 12 months): Other health reason 

q19_11 Reasons for not doing activities at all/more often (last 12 months): Lack of information on where to go / 
Don't know where to go 

q19_12 Reasons for not doing activities at all/more often (last 12 months): Lack of suitable places to go 

q19_13 Reasons for not doing activities at all/more often (last 12 months): Prefer to go to other places 

q19_14 Reasons for not doing activities at all/more often (last 12 months): Prefer to do other leisure activities 

q19_15 Reasons for not doing activities at all/more often (last 12 months): Wouldn't enjoy it 

q19_16 Reasons for not doing activities at all/more often (last 12 months): Prevented or discouraged by land 

owners / managers 

q19_17 Reasons for not doing activities at all/more often (last 12 months): Nervous or uneasy about what might 

happen (eg Personal safety, getting lost) 

q19_18 Reasons for not doing activities at all/more often (last 12 months): Not enough money / can't afford it 

q19_19 Reasons for not doing activities at all/more often (last 12 months): No-one to go with 

q19_20 Reasons for not doing activities at all/more often (last 12 months): Don't feel like I fit in / belong / am 
welcome 

q19_21 Reasons for not doing activities at all/more often (last 12 months): Lack of suitable means of transport / 
getting there 

q19_22 Reasons for not doing activities at all/more often (last 12 months): Dislike travelling 

q19_23 Reasons for not doing activities at all/more often (last 12 months): Not convenient 
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q19_24 Reasons for not doing activities at all/more often (last 12 months): Not interested 

q19_25 Reasons for not doing activities at all/more often (last 12 months): No particular reason 

q19_26 Reasons for not doing activities at all/more often (last 12 months): Other 

q19_27 Reasons for not doing activities at all/more often (last 12 months): Don't know 

q19_28 Reasons for not doing activities at all/more often (last 12 months): Not asked 

q20_01 Places visited (last 12 months): Woodland or forest 

q20_02 Places visited (last 12 months): Farmland 

q20_03 Places visited (last 12 months): Local park 

q20_04 Places visited (last 12 months): Other local open space 

q20_05 Places visited (last 12 months): Roadside pavement/track 

q20_06 Places visited (last 12 months): Hills, mountains or moorland 

q20_07 Places visited (last 12 months): River, lake or canal 

q20_08 Places visited (last 12 months): Beach 

q20_09 Places visited (last 12 months): Sea 

q20_10 Places visited (last 12 months): Other coastline 

q20_11 Places visited (last 12 months): Village 

q20_12 Places visited (last 12 months): Historic sites (e.g. castles) 

q20_13 Places visited (last 12 months): Gardens 

q20_14 Places visited (last 12 months): Other 

q20_15 Places visited (last 12 months): No answer 

q21_02 Places would like to visit at all/more often: Woodland or forest 

q21_03 Places would like to visit at all/more often: Farmland 

q21_04 Places would like to visit at all/more often: Local park 
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q21_05 Places would like to visit at all/more often: Other local open space 

q21_06 Places would like to visit at all/more often: Roadside pavement/track  

q21_07 Places would like to visit at all/more often: Hills, mountains or moorland  

q21_08 Places would like to visit at all/more often: River, lake or canal 

q21_09 Places would like to visit at all/more often: Beach 

q21_10 Places would like to visit at all/more often: Sea 

q21_11 Places would like to visit at all/more often: Other coastline 

q21_12 Places would like to visit at all/more often: Village 

q21_13 Places would like to visit at all/more often: Historic sites (e.g. castles) 

q21_14 Places would like to visit at all/more often: Gardens 

q21_15 Places would like to visit at all/more often: Other 

q21_16 Places would like to visit at all/more often: No answer 

q22a Views on changes in biodiversity in Wales 

q22b Views on future changes in biodiversity in Wales 

q23 Concern for changes to biodiversity in Wales 

q24_01 Activities undertaken in past 12 months to help protect environment and nature: Recycled 

q24_02 Activities undertaken in past 12 months to help protect environment and nature: Bought eco-friendly 

products 

q24_03 Activities undertaken in past 12 months to help protect environment and nature: Bought local food 

q24_04 Activities undertaken in past 12 months to help protect environment and nature: Walked or cycled rather 

than use the car 

q24_05 Activities undertaken in past 12 months to help protect environment and nature: Reduced your home 

energy use (energy saving light bulbs, switching off appliances) 

q24_06 Activities undertaken in past 12 months to help protect environment and nature: Gardened for wildlife 

(including bird feeding) 



260119555 WORS Excel & SPSS weighting guide FV 

23 
July 2015 

q24_07 Activities undertaken in past 12 months to help protect environment and nature: Been a member of an 
environmental, wildlife, or conservation group 

q24_08 Activities undertaken in past 12 months to help protect environment and nature: Actively volunteered with 
a project or organisation to help protect the environment 

q24_09 Activities undertaken in past 12 months to help protect environment and nature: Signed a conservation 
petition or participated in a conservation campaign (online) 

q24_10 Activities undertaken in past 12 months to help protect environment and nature: No answer 

Gender_01 Classification: Male 

Gender_02 Classification: Female 

Age_01 Classification: 16 to 24 

Age_02 Classification: 25 to 34 

Age_03 Classification: 35 to 44 

Age_04 Classification: 45 to 54 

Age_05 Classification: 55 to 64 

Age_06 Classification: 65 to 74 

Age_07 Classification: 75 to 84 

Age_08 Classification: 85+ 

Age_09 Classification: Refused 

Ethnic_origin_01 Classification: White - Welsh 

Ethnic_origin_02 Classification: White - Other British 

Ethnic_origin_03 Classification: White - Irish 

Ethnic_origin_04 Classification: White - Other White Background 

Ethnic_origin_05 Classification: Mixed  

Ethnic_origin_06 Classification: Asian, Asian Welsh or Asian British 



260119555 WORS Excel & SPSS weighting guide FV 

24 
July 2015 

Ethnic_origin_07 Classification: Black, Black Welsh or Black British 

Ethnic_origin_08 Classification: Chinese or other ethnic groups 

Ethnic_origin_09 Classification: Refused 

Qualifications_01 Classification: Not yet finished school - no qualifications 

Qualifications_02 Classification: Never went to school 

Qualifications_03 Classification: Higher Education & professional/vocational equivalents 

Qualifications_04 Classification: Other Higher Education below degree level 

Qualifications_05 Classification: A levels, vocational level 3 & equivalents 

Qualifications_06 Classification: Trade Apprenticeships 

Qualifications_07 Classification: GCSE/O Level grade A*-C (5 or more), vocational level 2 & equivalents 

Qualifications_08 Classification: GCSE/O Level grade (less than 5 A*-C), other qualifications at level 1 and below 

Qualifications_09 Classification: Other qualifications 

Qualifications_10 Classification: Other vocational or professional or foreign qualifications 

Qualifications_11 Classification: No qualifications 

Qualifications_12 Classification: Other 

Car_van_access_01 Classification: car access 

Car_van_access_02 Classification: No car access 

Bicycle_access_01 Classification: Bicycle access 

Bicycle_access_02 Classification: No bicycle access 

Own_care_dog_01 Classification: own/care for a dog 

Own_care_dog_02 Classification: do not own/ care for a dog 

Illness_disability_01 Classification: With illness/ disability 

Illness_disability_02 Classification: No illness/ disability 
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Limiting_illness_disability_
01 

Classification: Yes 

Limiting_illness_disability_
02 

Classification: No 

Carer_01 Classification: Yes 

Carer_02 Classification: No 

Children_under_16_01 Classification: Yes 

Children_under_16_02 Classification: No 

Working_status_01 Classification: Working full time 

Working_status_02 Classification: Working part-time (9 to 29 hours per week) 

Working_status_03 Classification: Unemployed - less than 12 months 

Working_status_04 Classification: Unemployed (long term) - more than 12 months 

Working_status_05 Classification: Not working - retired 

Working_status_06 Classification: Not working - looking after house/children 

Working_status_07 Classification: Not working - long term sick or disabled 

Working_status_08 Classification: Student - in full-time education 

Working_status_09 Classification: Student - in part-time education 

Working_status_10 Classification: Other 

Working_status_11 Classification: Refused 

Household_income_01 Classification: Up to £15,599 (net) 

Household_income_02 Classification: Up to £5,199 

Household_income_03 Classification: £5,200 to £10,399 

Household_income_04 Classification: £10,400 to £15,599 

Household_income_05 Classification: £15,600 to £31,199 (net) 
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Household_income_06 Classification: £15,600 to £20,799 

Household_income_07 Classification: £20,800 to £25,999 

Household_income_08 Classification: £26,000 to £31,199 

Household_income_09 Classification: £31,200 to £49,999 (net) 

Household_income_10 Classification: £31,200 to £36,399 

Household_income_11 Classification: £36,400 to £41,999 

Household_income_12 Classification: £42,000 to £45,999 

Household_income_13 Classification: £46,000 to £49,999 

Household_income_14 Classification: £50,000 to £79,999 (net) 

Household_income_15 Classification: £50,000 to £79,999 

Household_income_16 Classification: £80,000+ (net) 

Household_income_17 Classification: £80,000 to £99,999 

Household_income_18 Classification: £100,000 or more 

Household_income_19 Classification: Don't know 

Household_income_20 Classification: Refused 

rc1 Willingness to be re-contacted 

nssec NS SEC 

s3 How many people aged 16 or over currently live in household 

ethnicity ethnicity 

tier_1 Environmental concerns: Tier 1 

tier_2 Environmental concerns: Tier 2 

tier_3 Environmental concerns: Tier 3 

tier_4 Environmental concerns: Tier 4 
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tier_5 Environmental concerns: Tier 5 

wimd2 Bottom 10% : Wales Index of Multiple Deprivation (WIMD) 

wimd3 Bottom 20% : Wales Index of Multiple Deprivation (WIMD) 

wimd4 Bottom 30% : Wales Index of Multiple Deprivation (WIMD) 

wimd5 Top 10% : Wales Index of Multiple Deprivation (WIMD) 

urbanrural2 Town Fringe : Urban-Rural 

urbanrural3 Urban : Urban-Rural 

urbanrural4 Village Hamlet Isolated Dwelling : Urban-Rural 

communitfirstold Community First Old 

communitfirstnew Community First New 

rweightw rweightw 

serno SerialNumber 

q5time q5time 

q10time q10time 

noinparty noinparty 

SpendFood SpendFood 

SpendPetrol SpendPetrol 

SpendParking SpendParking 

SpendFares SpendFares 

SpendHire SpendHire 

SpendPurchase SpendPurchase 

SpendMaps SpendMaps 

SpendGifts SpendGifts 
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SpendAdmits SpendAdmits 

SpendOther SpendOther 

SpendTotal SpendTotal 

RespondentWeight Visit based weight 

VisitWeight Respondent based weight 
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